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About file formats

There are literally thousands of file formats. In general, if you have the program that creates a specific file format, that program can open and use any file that has been saved in that format. Some file formats (for example, the GIF file format used for Web page images) are standard formats that can be opened by any program that supports that standard format. 

You should take a moment to browse through your hard drive looking in various folders, particularly the operating system directory, observing the variety of file extensions indicating the variety of file types. Ensure that you don’t make any changes to or delete any system files.

Note: Sometimes the list of files has been set so that the extensions aren’t shown. You can change this by changing the ‘view’ options for viewing files and folders from the desktop. To find the view option, look under the system menus when you are in the desktop.

What is a file format?

A file is a collection of data which can be manipulated as a single entity, for example, moved from one file directory to another. The file must have a unique name within its own directory. 

A file format defines an exact structure for the data contained in it. An application recognising the format can read information about the file and its contents from expected places in the file. Often a file can only be read by the application that created it. However, if the specification for a file format is shared, then other applications can read it.

File extensions

Files with given formats often have a particular suffix (usually three or four characters after the file name). This is called the file extension. For example, a Word file most commonly has a .doc suffix. Generally the suffixes are chosen as a code to identify the format within a limit of just three characters. 

Different file formats

Since you started working with files on computers, you will have noticed the letters that often follow a file name. 
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	Do you know what these letters mean?


See if you can identify what types of files are listed on the left. Draw a line to the correct description.

	resume.doc
	image file

	myband.wav
	text file

	homepage.html
	sound file

	birthday.gif
	World Wide Web (Internet) file


How did you go?

Did you know or guess that:

· resume.doc is a text file 

· myband.wav is a sound file 

· homepage.html is a World Wide Web file 

· birthday.gif is an image file.
These are all different file formats. If you could open them up and look inside at the way the data is stored, they would each look very different to each other. That is why there is not one single software program that can open and display the contents of every single file type in a meaningful way. 

Every file format in the world 

There are absolutely thousands of different file formats. To get an idea of the number that exists, check out the website: http://whatis.techtarget.com/. Do a search using ‘file formats’ as the key terms and then click on the File formats link. This will take you to a page where you can click on ‘Every File Format in the World’. This contains a list of file name extensions or suffixes that indicate the format or usage of a file format and a brief description of that format. 

Other sources of information on file formats are: 

· ‘Paul Oliver’s Wotsit’s Formats’ website at http://www.wotsit.org/ 

· Webopedia website at http://www.webopedia.com/ 

Software versions and compatibility

What are the numbers that follow software names? For example, Microsoft Word 6, Filemaker Pro 4.1, Flash 5. 

Version numbers

As you may know, these numbers are version numbers. Version numbers identify the particular release of a piece of software. Version numbers can signify major changes to the software (such as new or revised features), or less major changes (such as bug fixes or minor changes to features). 

File compatibility

Generally, a new version of a software application is able to read the files created by earlier versions of the same application. So WordPerfect version 8 will be able to read the files created by WordPerfect version 6. 

The opposite is not true, and version 6 will not be able to read files created by version 8. (It’s obvious isn’t it? When they created version 6, they didn’t know what changes they would make in the future!). Therefore, if colleagues need access to your data files but have an older version of the application, you will need to Save As the files in a format that is compatible with the older version of the application in order for your colleagues to be able to read the files.

Warning: The ability to read past versions does not always apply to Microsoft Access files. You would need to carry out a conversion process in the new version. However, because database systems can be quite complex this conversion does not always succeed in recreating all of the associated functionality of the old system. 

Sometimes you will need to keep old versions of the same software to run the system until a complete upgrade process has been carried out.

Importing and exporting data

The ability to import (ie bring in or insert) data from one source to another and the ability export data from one application to another are very useful processes. They enable the user to utilise existing data without the need to re-create/retype the content, and therefore reduce duplication of effort. Importing and exporting functions also enable data to be easily presented within more than one format, eg charts and tables from spreadsheets can be integrated within a word-processed document.

Importing data from different file formats

Data can be imported from different file formats using the Object Linking and Embedding (OLE) functionality of the operating system. This is done by first selecting the data (eg highlighting part of a text or clicking on an image) then copying or cutting the selection (using Copy or Cut from the Edit menu). In another open file (that could be a different format) you then position the cursor and Paste (Edit menu) and the selection is placed here. For example, text from an MS Word file (document format) can be copied and pasted into MS Paint (bitmap graphic format). This method allows just portions of a file to be imported.

Importing can also be achieved by using an ‘insert’ or ‘place’ function that can import whole objects or files into an open document. For example, in Microsoft Word, the Insert menu /Object and allows one whole file to be inserted (imported) into a word document. For example, you can import a worksheet from a spreadsheet application or a PowerPoint slide to a page in your word document.

Exporting data to different file formats

Think about this situation. You’re working on your resumé in Word 2000 and you want to send it to a friend by email for him to check. The problem is that your friend doesn’t have Office 2000 on his computer, he still has Office 97. What will you do so that he can read your document?

Could you think of anything? You’re right if you suggested saving the document in the format of an earlier version of Word.

Example: Using ‘Save As’ to export data from MS Office 

If you’re using MS Word 2000 or MS Excel 2000 and you want to give a copy of the document to someone who is using Office 97 you can create a file in the correct format. You do this by opening your Word or Excel document and selecting Save As instead of Save. 

Then select the format you need. If you look at the Save As command you’ll see that there are many different formats you can choose to save your file in. Another common format to transfer Word documents is .rtf or rich text format. This format can be both opened and written to by most of the recent Word versions.
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Figure 1: Formats that Word 2000 can save to
On the other hand, the list of formats to which Excel can save data is shown in Figure 2. 
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Figure 2: Formats that Excel can save to
Familiarise yourself with the different ways that importing and exporting is achieved with the programs that you should now be quite familiar with — word processor, spreadsheet and database packages.

Other ways of exporting

Portable document format (PDF)

A popular document format for transferring finished documents to the Internet or for output to a printer is PDF, which stands for portable document format. A PDF retains the layout of the original document that may integrate text, graphics, video and interactive objects, so that the user can’t change the document without the software that creates a PDF.
You can’t create a PDF using the Save As command. You’ll need a program from Adobe called Adobe Acrobat. Also, the plug in Acrobat Reader is required to view PDF files.

Find out about creating PDF files from the Adobe website at: www.adobe.com. Look under the ‘Products’ category.

Tab or comma delimited files 

A common way to transfer data between different formats is to convert the data into a tab or comma delimited file. This data can then generally be read by almost any application including spreadsheets, databases, most project management software and accounting packages.

Delimited data has each section of data (word, phrase or value) separated from the next by a special character called a delimiter, which can be a comma, space, colon, tab or any other predefined character. This is done so that it may be imported, edited and/or read by another application that can create columns or tables such as a spreadsheet, word processor and database.

The file extension .csv indicates that it is an unformatted text file of Comma-Separated-Values (CSV).

Example: Exporting data as a tab delimited or comma delimited unformatted text file from Microsoft Excel

1
From within your Excel file choose Save As from the File menu.

2
Select the location and name the file in the usual manner.

3
In the Save as type: area, use the ‘down arrow’ to select:

–
CSV (Comma delimited) (*.csv), or 

–
you can choose to export the file as a Tab delimited (*.txt) text file (also in the drop-down list)

4
Click on the Save button.
[image: image4.png]Favorkes

My Network.
Places.

B

Bl & a

€' B ~ Todls -

File pame:

Save as type:

[Bocki s

[Mierascft Excel Warkbook (*k)

(Tompiate (k)

IText (Tab delmitec) (%)

lUnicode Text (%)

[Mirosoft Excel 5.0/95 Workbook (*.xis)

IMirosoft Excel 37-2002 85,095 Workbook (*.4k)

|5 (Comma delimited) ¢*.csv)





Figure 3
Exporting data as a comma-delimited or tab-delimited unformatted text file from Microsoft Access

From within you database:

1
Choose the table that has your data to be exported. For example, a table might store this data like so:
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Figure 4
2
Select the Export option on the File menu.

3
For Save as type: choose ‘Text Files (*.txt; *.csv; *.tab; *.asc)’.
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Figure 5
4
Specify a location to Save in and also a file name if not the same as that of the table.

5
Click on the Export button.

6
Choose Delimited rather than Fixed width in the next dialogue box and you can see how the columns of data from the table have become comma-separated values.
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Figure 6
7
On pressing the Next button you are given the choice of which character to use as the delimiter. 

You can either Finish or hit Next to reset the location of the file to be created/saved and then you are finished.

Use of different disks

Transferring files

Depending on the hardware components and connections you have installed on a computer, there are potentially many different ways to transfer files between users or computers. For example, you can transfer computer files via:

· CD ROM

· DVD

· digital video recorder

· email

· uploading to an Internet or Intranet site

· copying direct to another computer across a network

· USB (thumb) drive

· floppy disk

· Zip disk.

Compressing files

For all of these methods of file transfer, file size is a very important issue. For example, a CD ROM has the capacity to transfer much greater amounts of data compared to a floppy disk or via an email attachment. Transferring very large files across a network can also slow the network down for other users or even clog the network if more than one person starts to transfer large files. 

When file size is problematic, it is advisable to compress large files or a set of files into a smaller single file before transferring it/them. There are a number of methods or standards for file compression, each generating their own file type with related file name extension (see Figure below). It is advisable to use the more common ones so the receiver of the compressed file is more likely to have access to a utility to decompress your file. 
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Figure 7
The most commonly used compression format is the zip file (different from a Zip disk) and there are lots of programs written to compress/decompress zip files; the most popular being WinZip. Some of the other more popular models are NetZIP for Windows, MacZip for Macintosh users, and Zip and UnZip in UNIX systems. The zipped files take up less storage space and take less time to send to someone. 

Example: compressing and uncompressing a file using a PC

Most compression software attaches itself to the computer’s file management software as it is being installed. This means that the compression tool is readily available within the file management software. For example, Winzip embeds itself so that all you need to do is select the file/s that you wish to compress and then right click on the selected file/s. From the list of options choose Send To and then Compressed (zipped) Folder.
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Figure 8
The steps after this are easy to follow. The result of zipping is a single file with a .zip suffix. It can also be made into a self-extracting file, which will have .exe as its suffix. This is just a matter of selecting a checkbox in the dialogue box of the compression software along with choosing the location of where to save the compressed file.

After you download or otherwise receive a zip file, you extract/decompress the original files before using them. Most software that you download from the Internet will arrive as a zip file. 

When it is a self-extracting file you can double-click on it and it will automatically extract and store the individual files. If it is a .zip file you will need to have the program to carry out the decompressing. Shareware and freeware versions of various zip/unzip programs can be downloaded from http://www.shareware.com/
The process of unzipping compressed files starts with double clicking on the file name. This will run the unzip program installed on your machine which will open the zipped file and display the compressed file/files inside. Usually a button on the program’s Toolbar offers to extract the files, and if you click on it you will be asked to choose the files you want to unzip and where you wish to save them.

Summary

A file format defines an exact structure for the data contained in it. In some cases a file can only be read by the application that created it. However, if the specification for a file format is shared, then other applications can read it.

Files with given formats usually have a particular file extension (usually three or four characters after the file name). There are many websites where you can look up information about using any of the different file formats that exist.

You need to know the file formats that your software can open and modify, as well as the file formats that your software can save a document as. This will enable you to save, convert and import data wisely for use in another and software package.

There are a number of software tools that will allow you to share or convert data to use in a different file type to the one that created the data. These are:

· copying and pasting (from one open document to another)

· using ‘Save As’ to convert a file to an earlier version of the software or to change the file format to one that will be able to be read by another software package

· using a specialised software package to convert a document to a standard or ‘global’ format such as Portable Document Format (PDF)

· using an ‘export’ function in the software to save the data as raw or unformatted text which can then be imported to a wide range of file types

· using an ‘insert’ function in the software to place objects into a document that has a different file format to the placed object.
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